# Table of Contents

OVERVIEW .......................................................................................................................... 1

THE INTERFACES ............................................................................................................... 1

CHOOSE THE SUPPORT TABLE TO USE - HELPDESK OR EXTERNAL CUSTOMER SUPPORT? ... 1

CHOOSE THE USER TABLE – EMPLOYEES AND END USERS ................................................. 3

THE COMPANY TABLE ........................................................................................................... 3

HIDING DEFAULT TABLES VS. DELETING THEM .................................................................. 4

CHOOSING USER GROUPS AND TEAMS ............................................................................. 5

GROUPS ................................................................................................................................... 5
  Staff groups ......................................................................................................................... 5
  End User Groups ............................................................................................................... 6

TEAMS ....................................................................................................................................... 6

SAMPLE USERS AND PERMISSIONS .................................................................................... 7

MODIFYING GROUP PERMISSIONS .......................................................................................... 7

WORKING WITH TABLES AND FIELDS ................................................................................. 8

WORKING WITH FIELDS ....................................................................................................... 8
  Adding a New Field .............................................................................................................. 9
  Removing a field you don’t want to use ............................................................................. 10
  Changing the Choices for a Choice field ............................................................................ 10
  Parent-Child Choice Dependencies ..................................................................................... 10
  Changing Status Values ...................................................................................................... 12
  Changing how Fields Appear on the Submission Forms ...................................................... 12
  Copying Fields from Another Table .................................................................................... 12

WORKING WITH LAYOUTS ................................................................................................... 13

DEFAULT WORKFLOW AND RULES SETUP .......................................................................... 14

SETTING UP INBOUND AND OUTBOUND EMAIL ................................................................. 15

CONFIGURE THE EMAIL SERVER ....................................................................................... 15

SET UP INBOUND EMAIL ...................................................................................................... 15

SET UP OUTBOUND EMAIL .................................................................................................. 15

IMPORT USERS AND ANY EXISTING DATA ........................................................................ 15
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROVIDING ACCESS TO AGILOFT</td>
<td>16</td>
</tr>
<tr>
<td>DEFINE CUSTOM LOGIN AND EXIT URL PAGES</td>
<td>17</td>
</tr>
<tr>
<td>OTHER GLOBAL VARIABLES</td>
<td>17</td>
</tr>
<tr>
<td>EDITING THE PROGRAM LOOK AND FEEL</td>
<td>17</td>
</tr>
<tr>
<td>STAFF INTERFACE LOOK AND FEEL</td>
<td>17</td>
</tr>
<tr>
<td>END USER LOOK AND FEEL SCHEMES</td>
<td>18</td>
</tr>
<tr>
<td>TAB ORDER AND REQUIRED FIELDS</td>
<td>18</td>
</tr>
<tr>
<td>CONFIGURING CHAT</td>
<td>18</td>
</tr>
<tr>
<td>CONGRATULATIONS!</td>
<td>18</td>
</tr>
</tbody>
</table>
OVERVIEW

This document tells you how to do minimal setup to go live with the out-of-the-box default implementation of Agiloft for customer support or helpdesk support.

While you can quickly build a highly customized system with this product, you can also do just an hour or two of setup and be ready to use the product as we have designed it based on our experience with best practices in running a support operation.

This document provides you with some orientation on the default configuration and gives you the information needed to put the default system to use.

Even if you plan to do a lot of customization and add to the system, we recommend that you review this document first to understand what is already there, since it is generally easiest to adapt to your purpose what is already built than to start from scratch.

THE INTERFACES

There are four separate interfaces for accessing Agiloft – the Staff Interface, a basic end user interface, a fully customizable, html-based end user portal, and a mobile interface based on the Android standard.

All administration is done through the Staff Interface. All licensed staff users typically access the system through this interface, and when you login as the admin user it is the interface you will see.

Users accessing the system through an unlimited end user license can be taken to either of the two end user interfaces, which are simplified interfaces with fewer options. One difference between the two interfaces is that the basic interface shows tabs dynamically based on the user group permissions, just like the staff interface. So different users may automatically see different tables and requests depending on their group membership. The custom portal also has the capability of showing different items on the screen based on group membership, but this is not done automatically, but rather based on html codes that you must insert. So it can take a bit more work to set up, depending on how varied your end users are.

To view the basic end user interface as an external user, you can login from the main login screen with the login: customer and password: test22.

To view our sample implementation of the customizable portal, log in using the login string: http://yourhostname/gui2/eui2template/main.php?KB=yourkbname&user=internal&password=test22.

To login to the mobile interface, use a login string such as: http://yourhostname/gui2/login.jsp?KeyID=0&KB=yourkbname&user=admin&password=qwerty&State=Main&GUI=LowRes. The operative parameter is &GUI=LowRes to login to the mobile interface.

CHOOSE THE SUPPORT TABLE TO USE - HELPDESK OR EXTERNAL CUSTOMER SUPPORT?

To make life easier, we have designed two distinct tables to take as the starting point, depending on whether you are supporting external customers with support contracts, SLA’s, company information that needs tracking and so on, or whether you are supporting internal company employees in a helpdesk-type application.
The **Support Cases** table is set up for external customer support use and includes fields for tracking support contracts and client company information. If you are supporting external customers, you will generally want to use this table.

The **Helpdesk Cases** table is set up for managing typical helpdesk issues for employees, which we refer to as internal customers. It is simpler in terms of fields and relationships because it doesn’t need to track support contracts, company information and so on.

To rename either table, go to Setup/Tables/select the table and click the Edit button, then just type a new singular and plural name in place of the original name. Any table can be renamed to suit your purposes.
**CHOOSE THE USER TABLE – EMPLOYEES AND END USERS**

The Contact table hierarchy holds all users of the system. It is configured by default with a top level Contact table and two user sub-tables, for Employees and End Users.

In general, all internal company employees go in the Contact/Employee table, while all company outsiders, whatever their function in the system, will go in the Contact/End User table. These tables have fields appropriate to the purpose – for instance the End User table has fields pulled in from the Company table such as company contract information, while the Employee table has fields for home contact information, manager, job information, and so on. Note that a user in either table may be a “customer” or a “technician” – the role of a user in the system is determined by group permissions, not by which table a user is held in.

The top level Contact table is intended to hold non-users of the system, such as sales leads or other people for whom you want to track contact information but who do not need to login.

You can add other subtables of the Contact table if you need them, but it is usually easier to distinguish types of user by the default choice field called Type of Contact:

![Contact Table Example](image)

**THE COMPANY TABLE**

If you are using Agiloft for external customer support, you will typically store information about your client companies in the Company table. This table has default fields for support contract information as well as company address and contact information. If you have existing data on your client companies, you can import it into this table (see below for Importing Data). You may want to add other fields in this table to hold additional information about your clients, such as their products, their support reps, and so on.

Even if all you want to do is keep track of your customers’ company name for now, we recommend using this table to store the Company Name, so that all users will have consistent spellings of their company name and so that new companies may be easily added by any staff members with the right to create a new record in the Company table.

The Company Name field in the Contact sub-tables is a link to the field in the company table. It is displayed by default as a box with lookup (see screenshot above), but if you have a smaller number of client companies, you can change the display type to a drop-down list. To change the
display, go to Setup/Tables/Choose Contact table/Edit/Fields/click the Edit icon next to the large set of linked fields from the Company table starting with City, go to the Display tab, and for the Company Name field, choose the “List of Values” option:

This will result in an alphabetized drop-down list of company values from the Company table being displayed in the user record.

Note that the company address fields are also pulled into the user record by default. If you need for your users to have addresses independent of their company, you can eliminate the linked address fields by removing them from the linked field set we just edited, and replace them with regular address fields (see below for information on how to copy existing fields from one table to another).

**HIDING DEFAULT TABLES VS. DELETING THEM**

In general we strongly advise you to hide rather than delete default tables that you do not want to use. You may not realize that a default table is essential to the functioning of some other table, and hiding a table is a safe way to eliminate it from view without breaking anything.

It is easy to hide any table from all users by going to Setup/Tables/Choose the Table/ and clicking the Deactivate button. Note that this option is only available for top level tables, and hiding it also hides any sub-tables of that top level table.

The table will still be available in the table tree and can be turned back on at any time, but it will disappear from the toolbar tab for all users.

To turn on a table that has been hidden, you can go back to the table tree and click the Activate button instead. This will make it visible to the admin group only.

If you want to turn it on for other groups, go to Setup/Access/Manage Groups/ edit the group you want to see the table, and click the Table tab in the group permission wizard, select the table from the tree, and scroll down to turn on access to the toolbar tab. The option: Show table on a Toolbar Tab? will be set to No. Change it to Yes and click Finish and the table will now be
accessible. If the option to allow access to the table is also set to No, you will need to set it to Yes and set up some other permissions for users to be able to work with the table.

You might also want to change other permissions for the table while turning it on.

Because many of the default tables are set up with sophisticated relationships to other tables, we do recommend trying to use the tables that are already built when they can be adapted to your needs, rather than starting fresh with new tables. For example, you might work with organizations called Agencies rather than Companies. Rather than creating a new table called Agency, just rename the company table and then remove any irrelevant fields and add any new ones needed.

Do not delete the Employee table, as it holds the admin user and is the default table used for integration with LDAP and other backend systems.

Don’t forget that you can rename any table to meet your needs. As a general rule it is better to reuse a table than to delete it, or at least to be sure you understand the purpose a table is serving before deleting it.

**CHOOSING USER GROUPS AND TEAMS**

Users in Agiloft belong to both groups and teams. A user can belong to multiple groups and both a primary team and additional teams. A user’s access to the system – the tables and tabs he sees, the records he sees, the fields he sees, and the menu actions he can perform - depends on his group membership. While you can create as many groups as you need, it is preferable from a maintenance perspective to keep the number of groups small.

A user’s primary team determines what look and feel scheme he sees – so you can have customers on different teams actually seeing a completely differently branded interface with different logos and colors. Staff Teams are used to define functional groups to whom tickets will be assigned and emails sent.

In brief, groups determine the content of what people see, while end user teams determine their look and feel and staff teams define working units.

**GROUPS**

There are two kinds of groups: staff groups and end user groups. The type of group is defined on the General Tab (the first tab) of the group permission wizard. End user groups can only edit their own records and access the system through the end user interface. The following groups are set up by default:

**STAFF GROUPS**

- **Admin** – for the administrator(s) of the system
- **Support Staff** – technical solving staff should go in this group
Sales – if you have sales reps accessing the system they would go in this group

Professional Services – for staff doing consulting work related to the Projects table

Anonymous – this is for anonymous users who need to be able to update their tickets by an email link

**End User Groups**

Customer – for external customers accessing the support case table – they can see only their own cases

Internal Customer – for internal employee end users who access the helpdesk case table

Customer Manager – for external customer managers who can do a bit more in the system than customers (they can see cases for all people at their company)

SelfRegistered User – if you enable self-registration, users are automatically put in this group, which can have more limited access permissions than the regular customer group if you like.

Guest – typically used with a default generic user (guest or register) to enable anonymous users to create a new record in any table, typically without seeing the rest of the interface

So if you are setting up the system for helpdesk management, you would put all users in the employee table, and you would put your end users in the Internal Customer group and your technicians in the Support Staff group. If you are using the system for external customers, you would put your customers in the End User table and put them in either the Customer or Customer Manager group.

If you need additional groups with distinct access permissions, you can easily create them by going to Setup/Access/Manage Groups, selecting an existing group that most closely matches the new group’s function, and clicking the Copy tab. You can also edit the permissions for any group from this screen.

To print out the detailed permissions for a group, go to the same screen, select a group, and click the printer icon.

A user’s group and team membership is defined in his user record – there are fields for groups and teams in the user record. So when you import or create your users, you will select their group and team membership at that time.

**Teams**

If you need to assign or escalate cases to different groups of technician users, you will want to create a team for each distinct set of technicians. Otherwise, you can simply put all your technicians in the default Support Team.

If you want to provide different look and feel branding to different sets of customers, you will need a separate team for each branding. Otherwise, all customers would go in the Customer Team or the Internal Customer Team.

To create a new Team, go to Setup/Access/Manage Teams and click the New tab. For consistency with the default teams, include the word Team in the team name, i.e. Engineering Team.
SAMPLE USERS AND PERMISSIONS

There are sample users from the main groups and teams in the default system. They all have the same password: test22. To understand the default permissions, it is helpful to login as each of these users and get a sense of what they can see and do in the system.

To see the system from an external user’s point of view, use this login:

login: customer
password: test22

To see the system from an employee end user’s point of view, use this login:

login: internal
password: test22

To see the system from an employee technician’s point of view, use this login:

login: chris
password: test22

MODIFYING GROUP PERMISSIONS

To modify the permissions for any group, go to Setup/Access/Manage groups/Edit the group. Select the Table you want to change, and then go through the remaining tabs to affect the permissions for that table. To set permissions for another table, go back to the Table Tab and select a different table then cycle through the remaining tabs again. Click Finish when done.
WORKING WITH TABLES AND FIELDS

Table tabs are displayed dynamically based on a user’s group permissions. Different users may therefore see different tabs.

If you want to hide a visible table from the view of a particular group, this is done through the access permissions for that group. Go to Setup/Access/Manage Groups, choose the group and click Edit, choose the Table tab, select the table you wish to hide, and scroll down to the option to "Show table on the toolbar?" and set it to No (see screenshot below).

You do not need to turn off "Allow access to the table," and it is best not to do this unless you are sure, because it eliminates all previously set permissions for that table, so if you later want to turn it on for this group, you have to start from scratch at setting up the permissions.

WORKING WITH FIELDS

The fields in any table may be easily modified. You may want to try out the system with the default fields and once you have seen how it works for you, add anything you need. At a minimum, you may want to change some of the choices for the "type of problem" fields. Here are some pointers for where to go to make typical changes.

In general, work with fields is done in the Table Wizard. The quick way to get there is by using the Setup Support Cases or Setup Helpdesk Cases link under the tables in the left pane:

Only admin users see this menu option, so if you do not see it, you are not logged in as an administrator.

You can get to the same wizard by going to Setup/Tables/Choose a Table/click the Edit button. Once in the table wizard, click the Fields tab to see all the fields currently defined for the table in alphabetical order:
Linked fields from other tables will be shown as a group, with the source table shown under the Data Type column.

**Adding a New Field**

From the screen shown above, mouse over the New button at the top of the table and choose the data type. If you are unsure about what data type to use, select the Help link for more details:

- Action button
- Append Only Text
- Billing field
- Calculated Result
- Choice
- Compound
- Currency
- Date
- Date/Time
- EMail
- EMail Pager
- Elapsed Time
- File with Versioning

Once having selected the data type, you cannot change it, so it is worth the time to review the descriptions of each data type in the help file. After selecting the data type, go through the field wizard to define the field options.

When you add a new field it will not appear to anyone unless you have

1) Given groups permission to see it and
2) Added it to the staff and/or end user layout on the Layout tab of the wizard (see below on managing layouts).
**Removing a Field You Don’t Want to Use**

There are several ways to remove a field from view without deleting it, and we recommend hiding rather than deleting most fields until you have a good understanding of the system. You can simply remove a field from the layout and no one will see it. You can also remove all permission access to it.

To avoid confusion, if you plan not to use a field, we suggest the following:

1) Edit the field – change the field label to prefix it with something like “Z-old”, i.e. Z-old-Number of Incidents. This will cause it to drop to the bottom of the field list on the field screen and will make it obvious when you see this field on a layout that it should not be used

2) Drag the field off the layouts so no one else will see it.

If you decide to delete a field and the integrity manager comes up and tells you it is used for a critical function, we recommend that you hold off on deleting it and simply hide it.

**Changing the Choices for a Choice Field**

It is easy to change the choices for any of the default choice fields, and again we recommend that you use the default fields rather than deleting them and creating your own, because there are pre-configured reports based on many of these fields. For instance, the Type of Issue field in the Support Case table is featured in several reports, as are the Type of Issue and Subtype of Issue field in the Helpdesk Cases table. If you prefer to call the type of issue field Category and use different choices, you can simply rename it, and then edit the choices, and all the pre-built reports will still work.

To edit the choices, simply click the Edit icon next to the field to bring up the field wizard. On the first screen click the Edit Choices button to bring up the choice list. Once the choice list is visible, you can drag and drop the choices to reorder them, edit any particular choice to change its value, delete existing choices, and add new choices. Then simply click Finish to save the new choice list and click Finish to save the field.

**Parent-Child Choice Dependencies**

When editing choice fields, keep in mind that some choice fields may be a parent or child of another choice field (the child field’s choices depend on what is selected in the parent field). For instance, the Subtype of Problem field of the Helpdesk Cases table is a child of the Type of Problem field.

If you modify the choices in either a parent or child field, you will probably need to update the dependencies to associate any new parent choices with the appropriate child choices, and vice versa.
For instance, suppose you have the Type of Problem and Subtype of Problem fields in the Helpdesk Cases Table, and you add a new type of problem value called Facilities and some subtype values called Heating, A/C, Locks, Windows. Unless you map those child values to the new Facilities parent choice, no one will see the child values.

To do this mapping, edit the child field (Subtype of Problem, in our example). Go to the Options tab of the field wizard. If you have made a number of changes, click the Dependent Choice Wizard button to cycle through all of the assignment of choices.

If you have just added a new value or two, you can alternatively scroll down to just edit the parent choice that needs to be updated:

In this case, we might just edit the Facilities entry to assign the appropriate choices to it. This will bring up the dependent choice wizard screen for that parent value and we can multi-select the desired choices to appear:
CHANGING STATUS VALUES

Setting up workflow for a table creates a special kind of choice field named “wfstate” (this field is labeled as the Status field in most of the default tables). You can recognize this in the field table by the field name:

- Total hours to close
- Total_hours_to_close_swf
- Total_hours_to_close_swf
- Elapsed Time
- Type
- type
- type
- Choice
- Updated By
- _1903_full_name
- _1903_full_name
- Link to selected fields from other table
- Updater Login
- updater_login
- updater_login
- Contact full name

If you want to change the values for this field, it should not be done in the normal field table, but rather on the Workflow screen (Setup/Workflow/Choose the Table/click the Edit button), since there are special characteristics that need to be defined, such as the transitions that are enabled for each value.

CHANGING HOW FIELDS APPEAR ON THE SUBMISSION FORMS

If you want to change the display characteristics of any field itself, i.e. reduce the size of its input box, or change it from radio buttons to a drop-down, you do this by editing the field itself. Click the Display tab on the field wizard to modify the characteristics of the display.

COPYING FIELDS FROM ANOTHER TABLE

If you need to add fields to a new table that already exist in another table, the quickest method is to copy them. For instance, suppose you want to add standard address fields to a new table, you can copy them from a table where they already exist, for instance, the Company table. To do
this, go to Setup/Tables/choose the table where you want to add the fields/Click Edit/Fields and mouse over the New item and select “Copy fields (attributes only) from other table”:

Then you can choose the table that already has the fields, and select which fields you want to copy. This is a quick way to reproduce fields from one table to another.

**WORKING WITH LAYOUTS**

The layout of fields in the forms that users fill out is defined in the Layout tab of the Table Wizard. There are two layouts for any table, one seen in the End User Interface, and one seen in the Staff Interface. So you can arrange the fields differently to suit a different set of users.

If you want to change a field’s position in the form layout or add or remove it from the form, from the table edit wizard, click the Layout tab. See the diagram below for details on how to use the layout editor.

Drag fields down onto the layout from the staging area labeled Available Fields.

Drag fields from one tabbed screen to another by dragging them to the other tab (they will be inserted in the first available space on that tab).

Rename a tab by selecting it then clicking the Rename Tab button.
To preview the effects of your changes, click the Preview button:

This will open up a new record form in another window so you can see the effects of your changes.

Note that it is not currently possible to preview the end user layout – the preview button always shows the staff layout. To view the end user layout, you will need to login as an end user and navigate to the new record screen for the table (see below for end user logins you can use).

**Default Workflow and Rules Setup**

We have preconfigured several rules and workflow states for the support tables, which are fully documented in the Full Documentation for the Demo KB. These handle automatic acknowledgements to customers, notifications to staff and so on.

You can also view the Workflow setup by going to Setup/Workflow/ choosing the table and clicking the Edit button. This will bring up a diagram with all the states and their transitions. You can double-click on any transition with an action to view details about that action.

If you want to make any changes to the workflow states, go to Setup/Workflow/ choose the table, and click edit. You can add new states by typing them in the input box and clicking Add States, and you can drag and drop to add transitions between states. You can delete states and transitions, add actions to transitions, and so on.
To review existing rules, go to Setup/Rules and review the table of rules there. You can edit a rule to view its conditions and actions to see what it does. If you need additional escalation rules, you can easily create new ones.

The rules and workflow engine provide the real power of Agiloft. You may want to try out the system with the default setup before deciding what additional intelligence you would like to add.

**SETTING UP INBOUND AND OUTBOUND EMAIL**

Agiloft integrates both inbound and outbound email so that all emails are captured in cases.

There are three steps to setting up email.

**CONFIGURE THE EMAIL SERVER**

Go to Setup/Email/Configure Email Server and enter the information for your email server, following the onscreen instructions. If you are hosted on an Agiloft server, you can skip this step. Otherwise, if you have a mail sending system on the server, you can use localhost as the server on port 25 - try sending yourself a test email to see if this works. Then define the default outgoing email address to use for system emails.

**SET UP INBOUND EMAIL**

Whether or not you will allow end users to submit cases by email, you should still generally set up an inbound email account, so that if users reply to emails they are sent from the system, their reply is added to their original case, the assignee is notified, and so on.

To do this, you will first need to set up an email account on your mail server and note the account name, password, and IP or hostname of the mail server.

Then go to Setup/Configure Inbound Email, click New to create a new inbound account, choose your support table and proceed through the wizard, following the onscreen instructions. You will typically want to use as the inbound account the same address that you plan to use as the default outbound account for emails sent from the support table. On the Access tab you can decide whether or not unknown users can create or update tickets by email.

**SET UP OUTBOUND EMAIL**

Once you have set up your inbound account, go to Setup/Configure Outbound Email to set up the default outbound email options. Again choose the appropriate support table and follow the onscreen instructions.

You are now ready to send and receive emails!

**IMPORT USERS AND ANY EXISTING DATA**

15
Once you have the values you want in the choice fields and have the fields you need set up, you are ready to import any users or records that you would like to quickly get into the system. You can import from ASCII or Excel files.

Here are some tips on importing records:

- You should have a column in the import file for each field you want to import.
- You can have a first row with the field labels.
- The field columns do not have to be in any particular order, as you will be able to map them to the Agiloft fields during import.
- If you import data into a choice field, the choices in the import file should exactly match valid choices in Agiloft. If they do not, you can choose when importing an option to add any missing values to the choice fields. If you import group or team names that do not match groups in the system, the user will not be put in a group.
- If you are going to import end users and company records, first import the companies, so that they already exist when you import the users. Otherwise the appropriate links to the company data will not be created in the user records. This is a general rule: if you have created new tables, you should import first into the “source” tables before importing into tables that have linked fields from those tables, so that the necessary source records exist and links can be created.
- If you are importing users into different sub-tables, you can either do it as two operations (i.e. one import for employee table and one for end user table) or you can include a column in the import file for the table name into which the record should be imported. Be sure to use the correct case and spelling of the sub-table name in this case.
- When importing users, be sure to include columns for groups, primary team, teams, login, and password.
- If importing into a multi-choice field such as Teams or Groups, separate multiple choices in the import file by comma with no space.
  
  i.e. if you want to import a user into two groups, separate the group names with a comma, i.e. “admin,support”.

We have a spreadsheet formatted for users that has all of the standard fields to simplify gathering your user information. You can import that file very easily once you have filled it in.

To import your file, go to Setup/Import, upload your file, and follow the onscreen instructions to complete the import.

If you find you have made a mistake during import, you can mass edit several records at once to correct it, first finding the records you need to change and selecting them, and then clicking the Mass Edit button and following the onscreen prompts.

**Providing Access to Agiloft**

You should have a sample login page that was set up for your trial project or your downloaded project. You can take the html for the login block from this page and insert it at your own website support page or create a special webpage from which to launch the program.

If you want to permit self-registration or guest submission of cases, you can also put hyperlinks on your support page that allow direct access to the system without filling out a login.
The syntax for such hyperlinks is fully described in the online help manual. A typical link for self-registration of end users might look like this:

http://server7.supportwizard.com/gui2/login.jsp?keyID=0&user=register&password=register&project=Demo&state=New:contacts.customer&Table=Contacts&GUI=No/eui

This would login the user named register to a new user screen without showing the user any of the interface, so he could simply fill out the new user form and then exit.

A typical link for guest submission of a support case might look like this:

http://server7.supportwizard.com/gui2/login.jsp?keyID=0&user=register&password=register&project=Demo&state=New:case&Table=case&GUI=No/eui

This link logs in a guest user to the new support case form without any interface so he can simply submit a case and exit.

These hyperlinks use a user who is a member of the default group called Guest, and the fields that a user sees on these forms depends on the permissions of that group, so you can modify the permissions to enable or disable specific fields. To edit group permissions, go to Setup/Access/Manage Groups.

**DEFINE CUSTOM LOGIN AND EXITURL PAGES**

When a user logs out she is taken to the webpage defined as the ExitURL. A user may also be timed out or exited by the system, and in this case she is provided with a link to login again. This link points to a webpage that is defined as the LoginURL. Both of these variables should be edited to point to your own webpages, or they will bring up a default page.

To point the system to your login page for these situations, go to Setup/System/Manage Global Variables. If you see variables already defined for Exit URL and Custom Login page, simply edit these existing variables and put in your own URL. If not, create each item as a new variable of type URL. The ExitURL must be named with exactly this spelling and the LoginURL must also contain exactly this capitalization in its name for it to function correctly. The label of the variable can be anything you like.

**OTHER GLOBAL VARIABLES**

There are also variables that control the inactivity timeout for users, the locking time for records, and the title in the browser window. Default values are already provided, but you can edit any of these values from the Setup/System/Manage Global Variables screen.

**EDITING THE PROGRAM LOOK AND FEEL**

It is easy to add your company logo to the staff and end user interfaces and to modify the color scheme of the program. To modify the look and feel of either interface, go to Setup/Look and Feel/ and choose the appropriate option (Manage End User Schemes or Manage Staff Schemes).

**STAFF INTERFACE LOOK AND FEEL**

After selecting Manage Staff Schemes, you will see a table of all schemes. To keep the same scheme, edit the one that is currently set as the default. You can go through each screen of the wizard to modify the colors, or go directly to the Content tab to replace the Agiloft logo with your own logo by uploading your logo file.
When done with your changes, click on the Apply tab and be sure to select that the scheme should be applied to All Users.

**END USER BASIC LOOK AND FEEL SCHEMES**

You can have multiple look and feel schemes and apply each to a different team of customers if you like. You can start from an existing scheme and modify, then apply it when done. This is most easily accomplished using the basic end user interface.

To add your logo to the main end user scheme and edit the home page content, after selecting Manage End User Schemes, edit the one that is defined as the default for all teams.

Go to the Content tab. To upload your logo, scroll to the bottom of the screen and use the option to upload graphics to browse and upload your file. Then scroll back to the top and substitute your logo file name for the existing file name in the header HTML text section.

To edit the text content on the support home page of the End User Interface, edit the section titled Support Home Page Content.

When done, click on the Apply tab to apply your changes to all teams of users (unless you are supporting multiple schemes, in which case apply to whichever teams should see this scheme).

**TAB ORDER AND REQUIRED FIELDS**

You can also change the order of the tables in the left pane (and in the basic end user interface) and the way required fields are indicated (red asterisk by default) from the Setup/Look and Feel screen.

**CONFIGURING CHAT**

If you want to make live chat available to your end users, go to Setup/Chat and edit the default session. It has been disabled. Go to the Access tab and select the groups that you want to be able to see the Chat tab in the end user interface and that you want to be able to reply to chat requests. Also choose which teams of users should be notified when a new chat request is received. A popup will appear to users on that team.

When you’re done, click Finish and Chat will now be available to your users.

**CONGRATULATIONS!**

You’re done with the basic setup! Now you can start using the system and benefit from the work that has already been done for you.

We’re happy to help with any questions you have, and if you need more complex customizations, feel free to call on our experienced professional services team.